
 
Matchem Help Index

Welcome to Matchem Version 2.0!

Matchem is a matching board game designed to be played by both young children and 
adults alike.    Matchem features colorful game pieces (this version contains over 200 
different game piece images), stereo sound,    and a completely user customizable game 
environment.

Children will love the colorful game pieces and lively sounds.    Audio capabilities on 
number and letter games will actually pronounce the number or letter making Matchem and
excellent learning tool.    Also, you have the choice of the type of background music (if any) 
you wish to play during the course of the game - choose from a simple melodic drum beat, 
a classical piano rendition, or a more lively composition which will surely get your toes to 
tapping.

For adults, Matchem features a game timer that allows the player to set a game time limit 
and then play against the clock either with the gauge in view or, for those who like 
suspense, with the gauge indicator hidden.

And don't forget - Matchem has complete context sensitive help.    To quickly find help on 
a menu item, button, gauge, etc., click on the button containing the arrow/question mark 
(located on the toolbar) in order to put Matchem in the Help mode.    Then simply click on 
the particular control you need more help on.

Oh, and by the way, if you have not Registered Matchem - choose the Help-About menu 
option and click on the Help button located there.

For more detailed information on the Matchem game environment, click on the topic below:

Further Details

General Game Play Instructions

File Menu

Game Menu

View Menu

Help Menu

Common Questions

Contacting SparTech Software



General Game Play Instructions

The first time Matchem starts, default settings will be implemented.    These are geared 
more towards a first time player and may seem much to 'easy' as you progress through the 
Matchem game.    When you desire more competitive game settings, simply click on the 
Game-Options menu choice and customize the game environment to your liking.

The object of the game is to match all of the pieces on the game board.    To do this, click 
on a set of two game pieces.    If they match they will be removed from the game board 
(either automatically if you have the Auto Turnover option set or when you click the next 
game piece).    If they do not match, they will simply turn back over allowing them to be 
chosen again.

Upon game completion, Matchem will check to see if you have set a new high score.    If so,
you will be presented with the Game Complete Screen where you may enter your name.

If the timer feature is being used, the game can end in two different ways.    First, it may 
end when you have matched all of the game pieces.    The second way is when the game 
time limit has been reached.    If a timed game ends before matching all of the game 
pieces, you will hear the 'time out' buzzer and the game pieces will begin turning 
themselves over, showing you where the remaining matches were.

To start a new game, click on the New Game button (left-most button on the toolbar).    
This will reset the timer and create a new set of game pieces.

If during the course of the game, you wish to alter some of the game settings, simply click 
on Game-Options on the menu bar.    If you are playing a timed game, the game timer will 
be paused while you make your desired changes.



File menu commands

Menu items on the File menu will allow you to start a new game or exit the current game.    
The File menu offers the following commands:

New Game Start a new Matchem game!

Exit Exits Matchem.



Game Menu Commands

The Game Menu is where you will find all the options needed to configure Matchem to you 
liking.    The Game Menu offers the following commands:

Game Options Changes Matchem Game Play Settings

Sound On Turn on/off Matchem sound effects.

Music On Turn on/off Matchem background music.

Picture Game Pieces Play game using pictures of objects.

Number Game Pieces Play game using numbers

Letter Game Pieces Play game using letters

Pause Game Temporarily pause the Matchem game timer.



Game Options (Game Menu)

The Game Options screen allows you to configure Matchem to your own personal 
preferences.    For more information on the options for each of the individual dialog tabs, 
click on a topic below:

Board Layout Options Modify layout of the game board.

Game Environment Options Modify settings that affect the overall game environment.

Game Graphics Options Modify game graphics options

Game Sound Options Modify game sound options.



Board Layout (Game Options Menu)

The Board Layout dialog allows you to configure the Matchem game board to your own 
personal preferences.    You may set the number of rows and columns as well as the 'card 
backing' to use on the game pieces.

Note that the total number of game pieces used in the game will be the result of 'Rows X 
Columns'.    If you exceed the number of game pieces allowed for a particular game type - 
you will receive a warning message and the game layout will be corrected automatically.    

For example, a game based on upper case letters will have a total of 26 different game 
pieces available (one for each letter of the alphabet).    Therefore, you may not initiate a 
game using 60 game pieces (6 Rows by 10 Columns) since only 52 pieces would be 
available (26 times 2).

For further information on setting the Board Layout options, see Board Layout Options.



Board Layout Options

The Board Layout Options dialog allows you to set the following parameters:

Game Board Size:

Game Rows Set the number of horizontal game pieces.

Game Columns Set the number of vertical game pieces.

Card Backs:

Card Backs Set the card backing graphic.



Game Rows (Board Layout Options)

This setting dictates the number of vertical (down) pieces place on the game board.    You 
may select either 4 or 6 rows for the Matchem game.    If your new selection causes some 
of the game pieces to be located out of your viewing area, simply resize the Matchem 
window (by dragging one of its side bars).    Your new window size will be saved and used 
the next time you start Matchem.

Note:    If running in a lower resolution video mode (i.e., 640 X 480), you may need to 
disable viewing of either the Toolbar, Timer Gauge, or Status Bar if you choose to play 
using 6 rows.



Game Columns (Board Layout Options)

This setting dictates the number of horizontal (across) pieces placed on the game board.    
You may select either 4, 6, 8, or 10 columns for the Matchem game.    If your new selection 
causes some of the game pieces to be located out of your viewing area, simply resize the 
Matchem window (by dragging one of its side bars).    Your new window size will be saved 
and used the next time you start Matchem.

Note:    If running in a lower resolution video mode (i.e., 640 X 480), you may need to hide 
the Matching Gauge if you choose to play using 10 columns.



Card Backs (Board Layout Options)

This option allows you to set the 'card backings that will be displayed when a game piece is
not turned over.    Click on the card back desired and view the description located in the text
box below.    

The card backing indicated by a question mark (?) is a random card back feature.    Using 
this type of card back will cause Matchem to randomly choose a card back with each 
subsequent new game.



 Card Back Buttons (Board Layout Options)

These buttons represent the card backing you may utilize in the Matchem game.    To select
a backing, simply click on the desired button and then click OK to save you choice.



 Random Card Back Button (Board Layout Options)

Selecting this backing will cause Matchem to generate a randomly selected card backing 
with each new game.



 Card Back Text (Board Layout Options)

This text represents the name of the selected card backing.    It is for informational 
purposes only and cannot be edited.



OK Button (Board Layout Options)

Clicking this button will save all of the changes made and close the current dialog screen.



Cancel Button (Board Layout Options)

Clicking this button will close the current dialog screen without saving any changes made.



Help Button (Board Layout Options)

Clicking this button will bring up details on the Board Layout options that you may select in 
this dialog box.



Game Environment (Game Options Menu)

Game Environment options allow you to specify settings that affect the overall Matchem 
environment.    Settings such as game timer settings and game piece actions may be 
adjusted here.

For more information on setting the Environment options, see Game Environment 
Options.



 Game Environment Options

This dialog allows you to specify settings related to the overall Matchem environment.    

For more information on the dialog's fields, highlight the field in the dialog box and press F1
or click on the topic below.

Game Timer:

Timer On Set Matchem to use a timed game.

Time Limit Set the time limit to use in the game.

Game Piece Display:

Animation On Enable all Matchem animation capabilities.

Auto Turn Over Automatically turn pieces back over when 2 
pieces have been clicked.

Rate Rate that Exploding Turn Over animates.

Game Over Dialogs:

Show High Time Scores Upon game completion, display the high scores

Show Best 'Hit' Scores Upon game completion, display the high 'Hit' 
scores.



Animation On (Game Environment Options)

Setting this option on will enable all Matchem animation capabilities.    When starting a new 
Matchem game, the game pieces will be set up in an animated manner.    This type of 
animation may appeal to smaller children but may be turned of for adults who are playing a 
timed game.



Auto Turn Over Pieces (Game Environment Options)

Setting this option will cause Matchem to automatically turn over the game pieces when 
two (2) pieces have been selected.    You can adjust the turnover rate to make the pieces 
turn over slower or faster.

If you do not select this option, the two selected pieces will be turned over when you either 
click on another game piece, click on one of the selected pieces again, or click on an empty
game piece position.



Rate (Game Environment Options)

This setting adjusts the duration that the game pieces will remain showing when the Auto 
Turn Over Pieces option is being used.    



Game Timer On (Game Environment Options)

Setting this option on will cause Matchem to 'time' the current game.    When the specified 
Time Limit is reached, a buzzer will sound and Matchem will flip up the remaining game 
pieces to indicate where the remaining matches are.

The Timer Gauge does not have to be displayed in order for the timed game function to 
work.



Time Limit (Game Environment Options)

You may choose a game time limit from the pre-programmed limits specified in this drop 
down list.    The Game Timer On setting must be checked for this game time limit to 
actually take affect.



Show High Time Scores (Environment Options)

Upon completion of a game, you may elect to review the list of high scores in the Game 
Complete Screen.    Checking this option will cause Matchem to display a High Scores 
screen at the completion of a game.

Note that if you have set a new High Score, the High Score screen will automatically 
appear regardless of this setting.



Show Best 'Hit' Scores (Environment Options)

Upon completion of a game, you may elect to review the list of the Best Hit ratios in the 
Game Complete Screen.    Checking this option will cause Matchem to display a Best Hit 
Scores screen at the completion of a game.

Note that if you have set a new Best Hit Score, the Best Hit Score screen will automatically 
appear regardless of this setting.



Game Environment Help Button (Game Environment Options)

Clicking this button will open up help on the options you may select in this dialog.



OK Button (Game Environment Options)

Clicking this button will save all changes made and close the Game Environment dialog 
box.



Cancel Button (Game Environment Options)

Clicking this button will discard any changes made and close the Game Environment dialog
box.



Defaults Button (Game Environment Options)

Clicking this button will reset all options to pre-defined (internally in the Matchem program) 
settings.    These settings will not take affect until you click the OK button.



Game Graphics Options (Game Options Menu)

Game Graphics options allow you to customize settings related to the graphic display of the
game pieces.    Customizations related to the Letter game pieces and Number game pieces
may be set here.

For further information on setting the Graphics options, see Game Graphics Options.



 Game Graphics Options

This dialog allows you to specify settings related to the Matchem graphical environment.    
The following parameters may be selected:

Letter Game Pieces:

Upper Case Letters Use only upper case letters on game pieces.

Lower Case Letters Use only lower case letters on game pieces.

Both Upper and Lower Case Use both upper and lower case letters on game 
pieces.

Number Game Pieces:

Use Numbers 1 thru 10 Only Use only numbers 1 through 10 on game pieces.

Use Numbers 1 thru 20 Only Use only numbers 1 through 20 on game pieces.

Use Numbers 1 thru 30 Use numbers 1 through 30 on game pieces.



Upper Case Letters (Game Graphics Options)

Setting this option will cause Matchem to use only UPPER CASE letters in a Letter Type 
game.

Note that when only upper case letters are used, there will be a total of 26 game pieces 
available (1 for each letter of the alphabet).    This means that the total game pieces in the 
game cannot exceed 52 (as set by the rows and columns settings).    If you exceed this 
number, Matchem will issue you a warning message and automatically set the Letters 
options to use both upper and lower case letters.



Lower Case Letters (Game Graphics Options)

Setting this option will cause Matchem to use only lower case letters in a Letter Type game.

Note that when only lower case letters are used, there will be a total of 26 game pieces 
available (1 for each letter of the alphabet).    This means that the total game pieces in the 
game cannot exceed 52 (as set by the rows and columns settings).    If you exceed this 
number,    Matchem will issue you a warning message and automatically set the Letters 
options to use both upper and lower case letters.



Both Upper and Lower Case (Game Graphics Options)

Setting this option will cause Matchem to use both UPPER and lower case letters in a 
Letter Type game.

When playing in this mode, an upper case letter will not be a valid match for a lower case 
letters (i.e.    a 'B' will not produce a match with a 'b').



Use Numbers 1 through 10 Only (Game Graphics Options)

Setting this option will cause Matchem to use only the numbers 1 through 10 in a Number 
Type game.

Note that when only numbers 1 through 10 are used, there will be a total of 10 game pieces
available.    This means that the total game pieces in the game cannot exceed 20 (as set by
the rows and columns settings).    If you exceed this number, Matchem will issue you a 
warning message and automatically set the Numbers options to use all available numbers 
(up to 30 numbers are available internally to the program).



Use Numbers 1 through 20 Only (Game Graphics Options)

Setting this option will cause Matchem to use only the numbers 1 through 20 in a Number 
Type game.

Note that when only numbers 1 through 20 are used, there will be a total of 20 game pieces
available.    This means that the total game pieces in the game cannot exceed 40 (as set by
the rows and columns settings).    If you exceed this number, Matchem will issue you a 
warning message and automatically set the Numbers options to use all available numbers 
(up to 30 numbers are available internally to the program). 



Use Numbers 1 through 30 (Game Graphics Options)

Setting this option will cause Matchem to use all available Number Type game pieces 
available.



Game Environment Help Button (Game Graphics Options)

Clicking this button will open up help on the options you may select in this dialog.



OK Button (Game Graphics Options)

Clicking this button will save all changes made and close the Game Environment dialog 
box.



Cancel Button (Game Graphics Options)

Clicking this button will discard any changes made and close the Game Environment dialog
box.



Defaults Button (Game Graphics Options)

Clicking this button will reset all options to pre-defined (internally in the Matchem program) 
settings.    These settings will not take affect until you click the OK button.



Game Sound Options (Game Options Menu)

Game Sound options allow you to customize the audio capabilities of Matchem.    Settings 
such as the type of background music and enabling of human voice sound effects may be 
set in this dialog.

For further information on setting the Sound options, see Game Sound Options.



Game Sound Options

This dialog allows you to specify settings related to the Matchem audio environment.    The 
following parameters may be selected:

Sound Effects:

Enable Voice (Human) Sound
Where Applicable

Enable human voice sound effects where 
applicable.

Background Music:

Type of Music Set the type/style of background music.

Display MIDI Error Messages 
When Needed

Display MIDI error messages when they occur



Enable Voice (Human) Sound Where Applicable

Letter and Number type game pieces can use one of 2 sound effect styles.    Enabling this 
check box will cause Matchem to use a human voice (to vocally pronounce the 
letter/number) when a letter or number is clicked.    Unchecking this box will allow the 
normal sound effect to be used.

Note that use of this type of sound effect will slow down internal processing of the Matchem
software.    This may not be desirable if you are playing Matchem in a 'timed game' mode 
(i.e., trying to beat the clock).



Type of Music

Matchem can be configured to play background music during the course of a game (see 
Music On).    If the background music option has been enabled (via the Options Menu) 
then you may select the style of background music to play.

Note that some styles of background music go well with the other Matchem sound effects 
and others do not.    If the background music/sound effect combination does not sound 
quite right, you may wish to disable the normal Matchem sound effects (see Sound On) or 
switch to another background song.



Display MIDI Error Messages When Needed

Checking this option will cause Matchem to issue you warning messages whenever a MIDI 
error occurs.    MIDI error messages may be issued whenever the sound card cannot be 
found, if the sound card is not functioning properly, or if the Matchem MIDI sound files 
cannot be found.

Why did we include this option?    Nothing is more irritating than having Windows tell you it 
cannot find your sound card when you know good and well that it is there and working 
properly.    If you have a sound card that appears to be functioning properly and you keep 
receiving MIDI warning messages, you may uncheck this option to disable the messages.

Note that if this option is unchecked, Matchem will not warn you of any MIDI errors that 
may occur.    If you choose to ignore these warning, pay particular attention to the Matchem
environment.    If the game appears to hang often, crashes (particularly when you close the 
Matchem program), or if the background sound is distorted or stutters, you should try 
turning off the Music On and/or    Sound On option.



Help Button (Game Sound Options)

Clicking this button will open up help on the options you may select in this dialog.



OK Button (Game Sound Options)

Clicking this button will save all changes made and close the Game Sound Options dialog 
box.



Cancel Button (Game Sound Options)

Clicking this button will discard any changes made and close the Game Sound Options 
dialog box.



Defaults Button (Game Sound Options)

Clicking this button will reset all options to pre-defined (internally in the Matchem program) 
settings.    These settings will not take affect until you click the OK button.



Game Complete Screen

This dialog is displayed when a Matchem game is completed (as long as you have enabled
the Show High Scores and/or Show Best 'Hit' Scores on the Game Environment 
screen).    The scores will be separated by the number of game pieces used in that game.

This dialog comes in 2 flavors - one displaying the lowest times recorded and the other 
displaying the highest hit percentage recorded.    If the completed game resulted in a new 
high score, the appropriate line will be highlighted and the dialog will display the new high 
score and date and await the entry of your name.    If you do not wish to record this new 
high score, simply click on the Cancel button.

Note that you may clear the High Scores by editing the MATCHEM.INI file (in your \
WINDOWS directory) and removing all of the lines in the High Scores section (make sure 
you don't mistakenly modify any of the other settings - doing so may cause Matchem to not
function properly).



Score (Game Complete Screen)

Indicates the highest score to date.    In the 'lowest times' dialog, the score will represent 
the lowest (quickest) completion time to date.    In the 'best hit percentage' dialog, the score
will represent the highest (most accurate) hit percentage to date.

This field is not editable - Matchem will automatically determine and fill in your score for 
you.

Note:    The 'hit percentage' score is calculated by dividing the number of mouse clicks that 
produced a match by the total number of mouse clicks made during the game.    This 
calculation represents an indication of how accurate your guesses were.    In other words, 
the better you remember where the matching pieces are, the higher this score will be.



Date (Game Complete Screen)

Indicates the day and date score was set.    This field is not editable and will be filled in 
automatically by Matchem.



Name (Game Complete Screen)

Indicates the name of the person that set the high score.



OK Button (Game Complete Screen)

Clicking this button will save all changes made and close the Game Complete screen.



Cancel Button (Game Complete Screen)

Clicking this button will close the Game Complete screen without saving any of the 
changes made.



Help Button (Game Complete Screen)

Press help button to read further details on the Game Complete screen.
.



Wait/OK Button (Splash Screen and About Dialog)

Unregistered copies of Matchem will display an opening 'Splash screen' while Matchem is 
loading.    This screen features a delay function.    During the delay, the button will be 
disabled and its text will be 'Wait...'.    After the delay, the button will be enabled and will 
change into an 'OK' button.

Registering Matchem will remove this delay function.

For more information on Matchem registration, please see Registering Matchem 
Software.



Print Registration Button (Splash Screen and About Dialog)

Matchem is distributed under a concept called 'Shareware'.    This method of distribution 
allows the user (you) to try out the software before making a purchase.    The Matchem 
license agreement states that you have up to 30 days to make an evaluation of the 
software.    If you decide that you do not wish to purchase Matchem, you must remove it 
from your system.

Clicking this button will allow you to print the Matchem Registration form.    After filling out 
this form, mail it to the address specified on the form.    You will receive a user name, serial 
number, and registration key that you can enter at the Help-About screen in order to 
register your copy of Matchem.

If you are unable to print the Matchem registration form, simply mail us your name, mailing 
address, and EMail address along with your payment.

For more information on Matchem registration, please see Registering Matchem 
Software.    If you have any questions concerning Matchem registration, please see 
Contacting SparTech Software.



Register Button (Splash Screen and About Dialog)

Clicking this button will bring up the Matchem Registration screen where you may enter 
your User Name, Serial Number, and Registration Key (as supplied by SparTech Software).
You must make sure that you enter these criteria exactly as they appear on the form you 
received from SparTech Software.

For more information on Matchem registration, please see Registering Matchem 
Software.    If you have any questions concerning Matchem registration, please see 
Contacting SparTech Software.



Registering Matchem Software

Matchem is distributed under a concept called 'Shareware'.    This method of distribution 
allows the user (you) to try out the software before making a purchase.    The Matchem 
license agreement states that you have up to 30 days to make an evaluation of the 
software.    

Registering Matchem will disable the display of the opening Splash Screen and 
accompanying 'wait' feature.    In addition, you will be entitled to a 50% discount on all 
subsequent Matchem upgrades as well as a 20% discount on all other SparTech Software 
packages.

The registration fees are as follows (check/money order payable to Brian F. Haddock):

Matchem Registration Fee: $8.95
Postage/Handling (US Mail only) $1.00

Note that the $1.00 Postage and Handling fee is only required if you wish your registration 
packet returned to you via US Mail.    There is no additional charge if you receive your 
registration packet through you EMail account (and the turn-around time will be significantly
shorter).

To register Matchem, simply go to the Help-About screen (or the opening Splash Screen) 
and click on the Print Registeration button (if you are unable to print the registration form, 
simply send us your name, mailing address, and EMail address along with your payment).   
Please make checks payable to 'Brian F. Haddock'.

Once you have completed the form, mail it, along with your registration payment, to the 
following address:

SparTech Software
1309 Windy Meadows Dr.
Burleson, TX 76028

You will promptly receive a User Name, Serial Number, and Registration Key.    Once 
you have received these, go back to the Help-About screen (or the opening Splash Screen)
and click on the Register button.    Fill in the appropriate fields and click on the OK button.   
Matchem will now be registered and you will no longer see the opening splash screen (and 
wait feature).

If you have any questions concerning Matchem registration, please see Contacting 
SparTech Software.



User Name (Registration Screen)

Enter your User Name exactly as it appears on the Registration form you received from 
SparTech Software.    It is imperative that the name be correctly entered order for Matchem 
to be successfully registered.



Serial Number (Registration Screen)

Enter your Serial Number exactly as it appears on the Registration form you received from 
SparTech Software.    It is imperative that the serial number be correctly entered order for 
Matchem to be successfully registered.



Registration Key (Registration Screen)

Enter your Registration Key exactly as it appears on the Registration form you received 
from SparTech Software.    It is imperative that the key be correctly entered order for 
Matchem to be successfully registered.



OK Button (Registration Screen)

Clicking on this button will accept the registration information entered and attempt to 
register the Matchem software.    



Cancel Button (Registration Screen)

Clicking this button will discard any registration information entered and close the 
Registration Screen.



Sound On (Game Menu)

Setting this option on will cause Matchem to produce audible sound effects for events such 
as game pieces turning over, matches made, game timer prompts, etc.

If you do not have a sound card, disable this option.    You may also remove the sound files 
(*.WAV) from your hard drive to conserve space (although it is recommended that you keep
a copy of them off-line).

Shortcuts

Toolbar:



Music On (Game Menu)

Setting this option on will cause Matchem to play background music during the game and 
during certain events.

If you do not have a sound card then disable this option.    You may also remove the MIDI 
sound files (*.MID) from your hard drive if your sound card does not support MIDI or to 
conserve hard drive space (although it is recommended that you keep copies off-line).

Shortcuts

Toolbar:



Picture Game Pieces (Game Menu)

Setting this option on will cause Matchem to use 'picture' type game pieces (i.e., graphical 
representations of common objects).

If a current game is in progress, it will be reset (new game started).

Shortcuts

Toolbar:



Number Game Pieces (Game Menu)

Setting this option on will cause Matchem to use 'Number' type game pieces.    To set 
specific number ranges to use, adjust the settings in the Game Environment dialog.

If a current game is in progress, it will be reset (new game started).

Shortcuts

Toolbar:



Letter Game Pieces (Game Menu)

Setting this option on will cause Matchem to use 'Letter' type game pieces.    To set the 
specific types of letters to use (i.e., upper case, lower case, or both), adjust the settings in 
the Game Environment dialog.

If a current game is in progress, it will be reset (new game started).

Shortcuts

Toolbar:



Pause Game (Game Menu)

Setting this option on will pause the game in progress.    This action really only has 
meaning if a 'timed' game is in progress.    While the game is paused, all keyboard and 
mouse activity will be restricted.

Shortcuts

Toolbar:



View menu commands

View commands allow you to show or hide various components on the Matchem screen.    
This allows you to remove items in order to provide more room for the Matchem game 
board.

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.

Status Bar Shows or hides the status bar.

Timer Gauge Shows or hides the timer gauge.

Matching Gauge Shows or hides the matching gauge.



Timer Gauge (View Menu)

Setting this option off will remove the timer gauge from the Matchem screen.    This may be 
done for personal preferences or to allow more vertical room for game pieces.    A check 
mark will appear next to the menu item when the Timer Gauge is displayed.

Note that the Timer function will still work properly even if the Timer Gauge is not being 
displayed.    Further note that this menu option will be disabled if the Game Timer On 
option is not enabled.



Matching Gauge (View Menu)    

Setting this option off will remove the Match Gauge and Percent Matching Gauge from 
the Matchem display.    This may be done for personal preferences or to allow more 
horizontal room for game pieces.    A check    mark will appear next to the menu item when 
the Matching Gauge is displayed.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Index Offers you an index to topics on which you can get help.

Using Help Provides general instructions on using help.

About Displays the version number and registration info of 
Matchem.



New Game (File menu)

Use this command to start a new game in Matchem.    A new game can be started at any 
time.    The timer will be reset, music restarted, and the game board set up with new 
randomly placed game pieces.

Shortcuts

Toolbar:
Keys: CTRL+N



Exit command (File menu)

Use this command to end your Matchem session.    You can also use the Close command 
on the application Control menu. 

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in Matchem, such as New Game.    A check mark appears next 
to the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar    

The toolbar is displayed across the top of the application window, below the menu bar.    
The toolbar provides quick mouse access to many tools used in Matchem,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Start a new Matchem game.

Turn on game sound effects.

Turn on game background music.

Use picture game pieces.

Use number game pieces.

Use letter game pieces.

Pause the current game.

Display copyright/version info.

Invoke Matchem's help mode.



Timer Gauge (Main Game Board)

The Timer Gauge (located above the game board) will graphically display the elapsed time 
during the current game.    

The colored elapsed time indicator will be displayed in 3 colors - green, yellow, and red.    
Before the gauge reaches the halfway mark, it will be displayed in the color green.    After 
that it will be displayed in the color yellow.    When you are getting close to running out of 
time the gauge display will turn red.    Each time the color changes, you will hear a brief 
'popping' noise (if you have the sound options turned on).



Match Detail Gauges (Main Game Board)

This set of gauges displays information related to the number of matches you have 
currently made and the degree of accuracy you have demonstrated in making those 
matches.

The left gauge is the Match Gauge.    This gauge graphically indicates how close you are 
to matching all of the pieces on the game board.    The right gauge is the Percent 
Matching Gauge.    This gauge graphically indicates how accurate your guesses have 
been.



Match Gauge (Main Game Board)

This gauge, located in the Match Detail Gauges area, indicates how may game pieces 
you have matched relative to the total number of pieces on the game board.    When all 
game pieces have been matched. this gauge will reach the top.



Percent Matching Gauge (Main Game Board)

This gauge, located in the Match Detail Gauges area, indicates the percentage of guesses
you have made that have been correct.    This is an indicator of the accuracy of your 
guesses.

For example, if you have clicked two (2) game pieces (counting from the beginning of the 
game) and they made a match (how lucky!), this gauge will be colored to the top of the 
gauge area (indicating a 100% accuracy).    The gauge will be colored to the middle of the 
gauge area if half (50%) of your guesses have made a match.



Game Board Area (Main Game Board)

This is the main game board area.    Click on the game pieces to turn them over.    When a 
match has been made, the matching game pieces will be removed from the game board.

For further instuctions on playing Matchem, click on Game Instructions.



Guess Percentage (Status Bar)

This indicator displays the total number of guesses made and the percentage of those 
guesses that were correct.    A higher number indicates more accuracy in remembering 
where the pieces are located (or that youre very lucky).

See Status Bar for help on using the status bar.



Matches (Status Bar)

This indicator displays the total number of matches made and the total number of game 
pieces.

See Status Bar for help on using the status bar.



Timer (Status Bar)

This indicator displays the elapsed game timer.    This timer has nothing to do with the Time
Limit function in Matchem.

See Status Bar for help on using the status bar.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button and certain Matchem 
statistics. A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar    

The status bar is displayed at the bottom of the Matchem window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys 
to navigate through menus.    This area similarly shows messages that describe the actions 
of toolbar buttons as you depress them, before releasing them.    If after viewing the 
description of the toolbar button command you wish not to execute the command, then 
release the mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate the current state of the game:

Indicator Description

xx of xx Indicates how many game pieces have been matches and total
pieces on board.

xx at xx% Indicates the number of guesses and percentage of guesses 
that were correct.

xx:xx Indicates the current game time elapsed.



Contacting SparTech Software

SparTech software welcomes any questions, comments, or suggestions you may have 
concerning the Matchem game (or any other SparTech Software products).    If you have a 
question/comment, no matter how minor it may seem to you, we'd love to answer it!    
Feedback from our customers only helps us better our line of software products.

If you experience any 'bugs' or have any suggestions concerning ways we could improve 
our product, don't hesitate to contact us.    We support unregistered users in the same 
timely and consistent manner as we do our registered customers.

When contacting SparTech Software regarding software problems, please provide us with 
as much information as possible about the problem.    Be sure to include the version 
number of the software and details about your machine (CPU make and speed, video 
capabilities, sound capabilities, etc.).

The easiest way to contact SparTech Software is via our Web site at 
http://www.flash.net/~spartech.    Our Web site features an on-line bug reporting form, 
access to other SparTech Software products, user upgrade information, plus lots of 
freebies.    Stop by and visit us.

To contact SparTech Software, use either of the following addresses.

Email

SparTech@flash.net

Web

http://www.flash.net/~spartech

Snail Mail

SparTech Software
1309 Windy Meadows Dr.
Burleson, TX 76028 USA

Note that responses to correspondence sent via EMail will be answered much more quickly
that those sent via US Mail.

Note that SparTech Software cannot compromise software security by answering questions
concerning internal program security and or 'time-out' problems.    Although you will always 
receive a response to these types of questions, please understand that we cannot always 
resolve these types of problems.



Common Questions

Why does the first game piece automatically disappear when I click on the second 
game piece?

Why does the game not start up when I click OK on the opening Splash Screen?

Why is the 'Timer Gauge' option on the View menu disabled?

Why does the game animation and/or sound sometimes 'stutter'?

When I click on the toolbar or choose an option from the menu, the game refuses to 
respond?

What is the meaning of Life?



Disappearing Game Pieces

Why does the first game piece automatically disappear when I click on the second 
game piece?

This is probably due to the options you have set in the Game Environment Options 
screen.    Check to see if you have the Auto Turn Over Pieces option set.    If so then you 
may want to increase (make slower), the Auto Turn Over Rate setting.    



Matchem Does Not Start Properly

Why does the game not start up when I click OK on the opening Splash Screen?

The Matchem game has a built in 'time out' feature (at least we consider it a feature - you 
probably consider it a nuisance <g>).    When the evaluation period has expired, the game 
will no longer function.    You will still see the opening Splash Screen - which will allow you 
to register the software in order to reinstate the software's functionality.

Note that this problem may also occur if you have attempted to hack the program or it's 
internal security procedures.    If this is the case, contact SparTech Software for further 
instructions (no this is not a trap - everyone's done it and we would much rather 'bring the 
wayward back into the fold' rather than give you a hard time).



Disabled Timer Gauge Menu Option

Why is the 'Timer Gauge' option on the View menu disabled?

This is probably due to the Timer Gauge option not being set.    The timer gauge must be 
running in order for you to enable viewing of the gauge.



Stuttering Game Animation And/Or Sound

Why does the game animation and/or sound sometimes 'stutter'?

The Matchem game can at times place quite a strain on some systems.    This is due to the 
combination of animation, graphics, timers, and sound functions.    Some lower end 
machines may exhibit stuttering animation and/or audio under these conditions.

If your game exhibits these types of problems, you should experiment with the various 
settings until you have resolved the problem.    Start by turning off the Music On option.    If 
this still does not work, try turning off the Animation On option or the Game Timer On 
option.    If this still does not correct the problem, then please contact SparTech Software 
for further instructions.



Game Not Responding

When I click on the toolbar or choose an option from the menu, the game refuses to 
respond?

Check to assure that the game is not paused (the toolbar button with the picture of a 'hand'
on it will be depressed).    Release the game pause by clicking on the pause button or by 
choosing Pause Game from the Game menu.



Philisophy

What is the meaning of Life?

This is a fairly common question put to the SparTech Software development team.    We're 
sorry but we are currently unable to answer this question.    Our software development 
team is frantically searching for a solution but to date it has allusively evaded us.    Do note 
that we have not given up on our quest and hope to answer this question in the next 
version of Matchem.

Thank you for your patience.



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you 
can jump to step-by-step instructions for using Matchem and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 
Matchem.

If Matchem is not currently registered, you will also see the Print Registration Button and 
the Register Button.



Context Help command 

Use the Context Help command to obtain help on some portion of Matchem.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the Matchem window, such as another Toolbar 
button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application 
and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document

Restore button



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with 
the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the 
pointer to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog screen with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Matchem window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    Matchem determines 
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    Matchem 
determines which window is previous according to the order in which you opened the 
windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on 
the document Control menu closes only one window at a time.    You can close all windows 
at once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the program window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch 
to or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the
following options:
Task List
Select the application you want to switch to or close.
Switch To
Makes the selected application active.
End Task
Closes the selected application.
Cancel
Closes the Task List box.
Cascade
Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.
Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.
Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the 
AFX_HIDP_xxx values from the [ALIAS] section of your .HPJ file, and author a topic for each 
AFX_HIDP_xxx value.    For example, AFX_HIDP_INVALID_FILENAME is the help topic for the 
Invalid Filename message box. >>



Not Enough Game Pieces Message

This message indicates that you have a game board layout that will not accommodate the 
game type specified.    In other words, the number of game pieces you have specified is not
enough to accommodate the graphic type of game pieces.    

For example,    if you have chosen upper case letters as the game type, there will need to 
be at least 52 (26 times 2) game pieces in order to create a game based on this game type.

To remedy this situation, go to the Board Layout Options screen and choose a smaller 
number of rows or columns.



Not Enough Game Pieces Message

This message indicates that you have a game board layout that will not accommodate the 
game type specified.    In other words, the number of game pieces you have specified is not
enough to accommodate the graphic type of game pieces.

For example,    if you have chosen upper case letters as the game type, there will need to 
be at least 52 (26 times 2) game pieces in order to create a game based on this game type.

To remedy this situation, go to the Board Layout Options screen and choose a smaller 
number of rows or columns.



No MIDI Capabilities Message

This message indicates that Matchem was unable to determine if your machine has MIDI 
capabilities.    MIDI is a sound standard that must be supported by your sound card in order
for the background music to play properly.

If Matchem believes you do not have MIDI support, this message is displayed.    You may 
choose to ignore this message (see Game Sound Options).    If you do, Matchem will 
assume that your PC supports MIDI and will internally generate all the MIDI sound 
functions.    If your machine does not support MIDI, this could adversely affect the games 
performance and/or cause abnormal program terminations.



MIDI Lock-ups, crashes Message

This message is issued when you choose to ignore the No MIDI Capabilities Message 
warning.    If you do experience program abnormalities, try disabling the Music On option to
see if the problems clear up.



Evaluation Period Ended Message

This message indicates that the 30-day evaluation of Matchem has ended.    In order to 
continue using Matchem you must register the software (see Registering Matchem 
Software for further details).



Welcome To Matchem!

Welcome!    Thank you for evaluating Matchem.    We're sure you and your children will 
enjoy playing our game.

Remember, Matchem is distributed under the shareware concept.    For details on 
registering Matchem, please see Registering Matchem Software.

For specific instructions on playing Matchem, see Game Play Instructions.



Temporary Evaluation Mode Message

If you have received this message, then Matchem is operating in a special temporary 
evaluation mode.    This mode differs from the normal operating mode in 2 ways - first your
evaluation period is significantly shorter, and second, the opening Splash Screen 'wait' 
period is much longer.    This is done to discourage the repeated use of the Temporary 
Evaluation Mode in order to avoid program registration.

This operating mode is intended to be used only in emergency situations and should not be
used to bypass the normal registration procedures.    For more information on registering 
Matchem, please see Registering Matchem Software.



Secret Mode Message

This mode is sooooooooo secret, we won't even discuss it ...



Tampered With Message

If you have received this message then Matchem has detected that you have tampered 
with the internal or external registration parameters.    At this point, the program has been 
flagged as 'tampered'.    There are only 2 courses you may take at this point.

First, you may of course register Matchem and all tampering parameters will be removed.

Secondly, you may contact SparTech Software for further instructions on bypassing the 
'tampered with' program state.    Note that the procedures for bypassing this mode do inflict 
severe penalties on program performance and impose specific restrictions on program 
playability.



Program Evaluation Expired Message

This message indicates that the 30-day evaluation of Matchem has ended.    In order to 
continue using Matchem you must register the software (see Registering Matchem 
Software for further details).



Registration Complete Message

Matchem has been successfully registered.    Upon receiving this message, you may want 
to restart Matchem to assure that all registration functions have been implemented 
properly.    The first and most noticeable change you will see is the disabling of the opening 
Splash Screen and its accompanying 'wait' feature.    If you have experienced any problems
in the registration process, please contact SparTech Software for further instructions.

Once again, thank you for supporting the shareware concept.



Card Backing refers to the graphic image that shows on the back of the card (i.e. the way the 
card looks when it has not yet been turned over).



As of Release 2.0, Matchem animation capabilities include a animated setup of the game playing 
area only.    This differs from version 1.1, where there were several other animation sequences 
programmed. 



The 'hit percentage' score is calculated by dividing the number of mouse clicks that produced a 
match by the total number of mouse clicks made during the game.    This calculation represents 
an indication of how accurate your guesses were.    In other words, the better you remember 
where the matching pieces are, the higher this score will be.



The letter game pieces are simply graphical images of all the letters of the alphabet.    Matchem 
can be customized to display upper and/or lower case letters as well as produce an audible 
pronunciation of each letter.



The number game pieces are simply graphical images of the numbers 1 through 30.    Matchem 
can be customized to display numbers ranges of 1 through 10, 1 through 20, or 1 through 30 as 
well as produce an audible pronunciation of each number.



Matchem's audio capabilities include full stereo sound effects (when a game pieces is clicked, 
when the game has ended, when the timer reaches 50% and 75%, etc.) as well as stereo 
background music.



MIDI (Musical Instrument Digital Interface) is a musical standard supported by Windows and most
sound cards.    MIDI allows your computer and sound card to communicate (via MIDI messages) 
in order to generate advanced musical compositions.



The Splash screen is the opening screen seen in unregistered copies of Matchem.    This screen 
displays registration status as well as copyright information.    Registering Matchem will remove 
this splash screen and its accompanying delay feature.



Nope, no more info here on the 'secret'.....






